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Prior to importing your spreadsheet saved in csv file format, make sure
your data starts in cell A1, contains only Real numeric values, and does
not contain text
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Vi B : 7E CE 1) RAM FlI Archive 17 i #% 2 [A]1 £ 5)) Python AppVar

% [mem] 2:Mem Management/Delete... > B:Var App...

TEFREAS AppVar E 3% [enter], ) RAM )4t & Archive( F1 * & 7R) »
ERgge €N

> EPFFEURRE PR BT ER TR, ISR IURIE Bk TR AR (A
BRI .

A~ AppVar /& Python AppVar?
& AT 2 B8 DL R 75 2UAR IR Python AppVar.

1E TI Connect CE Calculator Explorer #', Python AppVar # ¥&. 7~ A “AppVar Python”.
iX B, SCRIPT1 Al VABSOLUE /& Python AppVars.

& GRAPH AppVar Python
g HELLO AppVar Python
g LINREGR AppVar Python

@%%:Python AppVar F] 5 1% A5 HoAth 8x R B HE A, (A NI i 5 g B
7)o

1% [mem] 2:Mem Management/Delete...> B:Var App... PY 7£ JiF 2 45 Il 7K .

[HORMAL FLOAT AUTO REAL RADIAN HF n

RAM FREE 148459

ARC FREE 1321K

» GRAPH 995 PY
HELLO 278 PY
*KEYS88G 523 PY
LINREGR 662 PY
*PRINT 67 PY
PYTHON®@1 143 PY
*ROVER 382 PY
*SALEPRC 235 PY

 Python AppVar & 3% 8% #: 2 7+ EHL( *.8xv B *.py)
T ¥ Python AppVar 1E N Python AppVar (*.8xv) B¢ Python F2 7 (*.py) M 115 2% &
R E R AL.
o {XAEN Python AppVar K% B 15 : T & Python 1) CE 1T 5 3%
FHHE5) Python AppVar, K H:AE v AppVar (*.8xv) XX 1F K% E i+ H AL .
o RIZZRITHNLE, ATESFAEN Python F2 /7 (*.py) HEAT Ki%:
- M Calculator Explorer "' #% $§ Python AppVar. 7~ %1 : AIRECARR
- 1%k P Actions>Send to Computer

- {RAFE) SN, S AppVar (*.8xv) X Python (*.py) 4 JE 4 .

Ao S as o a8 TIFIX 21



| HELLO.2xv

AppVar Python (*.8xv)
AppVar Python (*.8xv)
Python (*.py)

VLR

#4 Python AppVar & #[8] *.py 1+ F AL SCAF 5, 15 2 7 H ML Python
R ARV | L BE L 34T R R Python 45 E T H o it 2L E A8 A
) Python KA 3t 1T 06 ZE A48 240 . Python B AS % AN #H [

B e ok > py B2 AR AF B R HLI, B E SR E L G 2 R
FAEE I *py 2R, LA 5 IR U *.py FE T

R : F T 4T 7 1 22 H1/TI-Python experience: 7E i1 2 #L _E ) Python FF /& ¥R 55 v
B % Python 2 /7 5 , 1% 7£ TI-Python experience " 56 il 18 (1) 72 J7° /2 75 75 11 5 8% /
i H4% Ri4T . iR = BB T .

H 5% TI-Python I FELHMS KB, 155 W, Python App Hi 7151 .

22 fEHTF 5SS a8 T AE X


https://education.ti.com/html/webhelp/EG_TI84PlusCE-T/UK/index.html

EHEFRES LERX

IR g A AR X AT DLAL B TI-Basic R R

#2 Tl Connect™ CE - [u} X

@

s New Program

Open Program

-

1 FE 7 g 8 as T AEIX 23



P i 8 245 T1EX 1Y % 38 4

£2 TI Connect™ CE

4 New Program
Open Program

-

@ CREAR - X B T A E OO AR Y DL KGRI B

File Edit View Actions Help

WER AR O A AR X, RORERE P R P A AR

@O ILEE-LLHXEEEIRFERF . ITARF . REFREFIHE
Bl HBRFREIERK T EE. BOHREMR L LFRRDER,

00 0 (5] 6]
BT

THET.

FRE 7 R A7 2 B .

P AR 7 Rk 2R B 1T A A

S O e
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CIE e

(e IS NN SR PN RN N P T NI
o HITK
o ERFSHmERE

© WHREMR - AT m AT QI &R Mg H AT .

New Program

_I_

Open Program

-

O BRI - 6 AT B PR T AR SR, 2R S A H SRR AR (4R
) AT R LB R T

» Angle

» Catalog

* Char

*» Distribution
» Draw

* Finance

» Format
»List

» Math

» Matrix

* Memory

* Mode

> Program

» Statistics
» Stat Plots
* Table Setup
» Test

> Variables

» Zoom

1 FE 7 g 4 as TAEIX 25



[5) t_ﬁjgigﬁﬁ - o P AR AT R R A B IR I DL 7 A
u} Z> °

Syntax Reference

AsmConp (prgmASM1, prgnASM2)

G2

ARAT FFAL AR FE 7 B, PN 2 1R AR X 55 7~ “New Program( 31 22 72 /37 ) 1 “Open
Program( T JF#2 %) "l 5

RIEFESF it
» i New Program( BT &7 %) B #n .
THREFRER pen rogram
1. H.ii open Program({T &) B b5 . .ﬂ
2. AL A R A |
3. BT,

GBETELK

HRE T 4 FR AL PROG##H . % 5 2 I 7 £ ], 7= %1 : PROGO1. PROGO2.
FUBERFBRK

» 7E Var Name(ZE 4
FRBHTF(E N

>3

) HE P B Ty, SRS BB AR BT A AR B 8 A
) o

e M T
VAR NAME:  PROGO1

Ry ESF

1}?}@ TI Connect™ CE R I AL K 2 Fr A 3 B3 £ (0 1 55 4% 2 ) 5 7 1k 4 4 AR
7o

R EF

v kB EEEn e, M
K EFRIEEB G EH
B 44 FRTF K 1 2 B 1 P R A
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RERF

1.$$EIO

2. 5B AR R SRR
3. PR
KHEF

KABF

» REHRRT AR x.
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& Fi B 3 I 5%

s AR B3 v DU T B 22 72 7 1 o 55 2% A &

JRIT BT & B R Z 5]

>

RE R HRFH SR =ATE

TI-84 Plus CE

» Keypad
» Angle
» Catalog
» Char
» Distribution
» Draw
» Finance
» Format
» List
¥ Math
» Math
» Numeric
» Complex
» Probability
¥ Fraction
I
MFOD
rnfd4rUnid
» Matrix
» Memory
» Mode
» Progran
» Statistics
» Stat Plots
» Table Setup
» Test
» Variables
» Zoom

Syntax Reference

No reference available

B R BT SRR

) SRR -

VARNAME:  PROGO7

RERFHETHAEERF

>
G 1R A A AT H
B -
> Wl HRKH . X aH
Hh DL 8 A . B

R H Sk BT BN A IR P . XRETEMM I 5, FOthRE T

ﬁ%ﬁ%%fﬁ%ﬁﬁ
F 0 A
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WEARB VR R
{2 M5 B RIS B A%, B aEER S P REMNSHHAY
& TR VR R R
~H
BT Eval( if /2 eval(?
HENT sin( i8S Sin(?

H F W 51 £
RGN IEWRRY | T84 PluscE ~ *Untitled1.8xp X
KN s

*%*%ﬁ o DispGraph

DispTable VAR NAME:  PROGOL
»DMS
Dot-Thick
Dot-Thin
DrawF

l 281 eval(

Drawlnv
DS<(

e

e (

E

MEFF(
El=s
End

Eng
EqurString(
eval (
ExecLib
expr(
ExpReg
Exproff
Expron
Fcdf (

Syntax Reference

eval

BN SRR R
I H A LIBITEF
HFEFP AT S A LIS AT, WU A T B T BUB A R

R i as TAEX 29



oK 24 2150 2
W] L o i AR R, SRR TI VR e
Connect™ CE T2 J7 % # 28 & & 12 /7
RSN 2 b K R RO B 5
%%W,mwﬁﬁéﬁiﬁﬂﬁ%
i o

AR AE RS IS AT Y, WERAFAE AN M, WIAETE VR R R
Goto(ﬁ%@] %4%?‘619T§%:7i$$§‘ MR FAT o R B AT ML R A

AT KRR BAFAE BN M

VARNAME:  SNAKE

URMAL FLORT AT
|Pmmnnn LINE 11

1:Quit
PHGoto

ClrHome
1344
548

344D
Xadin (L1)
Xadin (Lz)

$Xadim(L1)

sX>dim(Lz2) AL
:Fill(B.L1)
tFill(A,L2) L2(P)," ")
iRereat KE45 Sfff?s%‘“ i
ALz (P)
/ B P+l- \(P =0+
7 getKe

Cursor lands on error. It la"(K {24,25,26,34})

A*(D 26) - (D=24) A
B+(D=3d)- (D=25)8
A+26( (A=B) - (A=27) )-A
B+108( (B=@)- (B=11))+B
End

o ROthRE AR Za TR
o AFANMIER BN A
WE A BB RO R
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'WORMAL FLOAT AUTO RCAL MADIAM P n 'WORMAL FLOAT ALUTO KEAL RABIAM RF n
PROGRAM : SNAKE
:ClrHome :ClrHome
:12+A :13+A
15+B 1548
1104X P10
1P 1P Spaces
1340 134D
) | Xsdim(Lall i¥edimils)  H
iXrdimilz) s rdimilz}
tFil11(B.L1} tF11liB.L1)

i SR THE AR A @ (BRE) 2

TERE 7 KB B TH S8 200, fr A & O TR AR G 2 (ARE) -

WRAE AR 7 SOE B A SR AR S A LIS AT I AR AR, TR A, &
S AR g A N IR A & 2 R S P B R A ARl

Lafa T RE?

i tfrﬁ%%iimjﬂ‘ﬂaﬁj‘ 7‘6*ﬁ:41?*”~/\?ﬁ£ SN SURTIAN
ARRIC T2 o MR AR IE NS R RS shad it ay &, Wz dy & R EAT 8 i,
TS5 25 I3 9 s iy &

- . PROGRRAM: B PROGRAM: B On the calculator, the cursor
— :EnvBinom( invBinom(Hl ; P ”

jumps over the “token.

It only understands the
characters as a function or
command name.

AR BT A BT, a4 ek s B E bR AT R

B B |27 98 45 A (1] LEFT. CENTER. RIGHT. FRAC) /& 1] B8 £ 76 - 445 i v fg
R 7. B R P EHRENTIASHHERGASHE, W% 5[ e
S Ra N K T Te ﬂﬁ% FEFE R AR AR R . B 5 TI-Basic i 4 M ]
R B A 4y, e T A bR e Ak A A .

%JICOnnect’”CEE‘JlnEmﬁéﬁﬁiiiﬁiﬂuﬁﬁﬁ%%ﬁﬁéﬁﬂﬁu 1‘mﬂ
I8 2R A [F 8 ) TI Connect™ CE 4T FFE 7 UL K R ik Bl E 28 AT RE & 3 3L
DL [a) 8
o RFEE A Fric f/ek
o IBVLAEIR

1 FE /7 o 48 4% T AEIX 31



& /15 1% 5 % R
EES B E S R B R H L, Q5% AT S,

Syntax Reference

Pt-Change(x,y[ .color#])

JH F Ti-Innovator™ FI Ti-Innovator™ Rover ] HUB 3 £

T2 7 4 45 4% % #F B T Tl-Innovator™ A TI-Innovator™ Rover iy % ) Tl-Innovator™
HUB 3¢ ., HUB 32 B4+ H M i) “Program( F2 /77) "3 B2 5, [A] TI Connect™
CE f2 /7 4 25 HE AT 1 HUB SRR N2 5 Hub B FH 2 )7 67 T CE v & %% LT
AH IR ) HUB SE B A4 B0 o 16 4R 24458 FH e 7 Wit A 1) CE OS AT CE Hub 7 FH #2177 -

VERE : W Program Editor Hub 2 AN & — S T 4R LR 4 in & L IR 75
B mMER PGS .

il 5508 - CE B A B R AT S8 8 -

- education.ti.com/84ceupdate

- education.ti.com/84cetupdate

AESH:
ﬁﬂ% E iﬁ”ﬁ ¥ Program
» Control
'I‘&J‘fiﬁjiliﬁﬁ‘ﬁ%g » Input/Output
¥ Colar
* HUE
®» Sond( "SET

» Send| "READ

* Settings

Wait

Get |

gval |

Rover [(RVW)...

» Spnd| "CONNECT-Output

» Send| "CONNECT-Input

k Forts

* Send( "RANGE

¥ Send( "AVERAGE

* Send | "DISCONMNECT -Output
® Send( "DISCONNECT - Input
*» Hanage
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XY & b
T DK R P 3 B3 e 1 o 58
BT RBIER NS

1.

a0 2R R AT IR AR B R

N
i |
FILE NAME( 3Cf4: 44 ) : iX 7] £ 5 NAME ON CALCULATOR( i858 F B &4 KR) A~
[A], B AR TP T E LI 2 FR .

NAME ON CALCULATOR( 5 #% L f1 44 #K) - LB 72 /7 44 R (& B2 BN
H, {2 A LR D custom( B E X)), SR P A FK) -

2 Name on Calculator = e S|
ttttttttttttttttttttttttttttttttt
I LINE v | RAM v
cccccc Custom Program names can be up to 8 characters in length
The first character can be A-Z or 8.
cted Calculators ® Select Calculators The remaining characters can be A-Z, 8 or 0-9

Replace existing content with the same name on destination calculators

CANCEL

LOCATION( £ B ) : & # /& 3 2 7° R A7 £ TF S 25 () RAMIE A7 RS v o

DESTINATION CALCULATORS( H #7 71 52 #%) - 6 502 ZOR R Fr RO B i 4 318 4%
M Th S g, R UAIE B T AR (Gl L ik R AR .

REFRBISNIES

1.
2.
3.

TE NG HE | % % Select Calculators( %G 3+ 44 585 ) 4% 4H .
R B E R T AR 5 A
B send( R i) .

BERE

MR BERH S HEVEERGES REAFEME S RIF K TI-Basic F£ 5, N
u] UL 2R A H A E = & 87 8 35 TI Connect™ CE.

1.
2.

% # File( 3Cf4) > Change Language( E 1B &) -
EEFRINHEFZ FIEFIES Fik.

1 FE 7 o 48 4% T AEIX 33



#2 Choose a language

Language changes will take effect after application restart.

English (US) v

QUIT LATER QuUIT NOW
* QUIT LATER( R J5 B ) - TR B L FE 1A & . XA 3) TI Connect™ CE I, T
Connect™ CE 2% F W AT 3% 15 = 5 3 .

o QUIT NOW(Z BP 3B ) - 3% H A8 B FIFE P - R IR S 3h TI Connect™ CE I, TI
Connect™ CE <= KX H ML AT &8 5 B 3.

o CANCEL(BUH)- AHEATIE S H i it EBRIERGE S 22N E.
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fHitHB

BRI T HE A

TI CE #8 9F A 3 -l — M SN SO BEHT CE TR !

{5 Fl TI ConnectTM CE I TI CE il 4540 — 5 T 7 46 3% 4% CE H 5488
s ) $5 3T 1) CE 1R A 0 AT B 387 -

education.ti.com/84ceupdate

education.ti.com/84cetupdate

¥ E<123E TF 528 EH2 2] T) Connect™ CE. 4 AH N2 TI CE Hf 46 A 46 5l 21 11 5 2% 0 W

Tl Connect™ CE 4= 531 CE OS LA &% % B 58 33 B i 5 3 o Sk 2D B9 AT ] CE I FH 72
F, B2 SATﬁjJDﬂZlgT%Ein*JZ@J Image1 — ImageS. LR AT Ik,
BE1E 4% 0 fd F TI Connect™ CE 115 3% 1 W8 #% £ A7 (6 7E) BT 2 B HITHE S X
o WTCATE ST TI CE 4B R 2 5, ¥ 2 5% 1o 588 SO 3E Bl ok 5 8% .

¥ CE R 100 HE 3 2] 11 5 2% 0 WS 2% L 1 25 B R AN IS R 58 i . 1 0 B AR AT
A i o T2 P R R o CE T AR 3 o A P AR BN N P R Y A e 2 T S BT S
B . CETHE 28 & 70 %0 F2 A 0 A B TR A7 R 38 ( T HE S N A7) - f
I, 2:7F Tl Connect CE & I F B R_7E B .

EEE 2% TICE #H G5 S04 5 7548 T LAAE education.ti.com/china I B T 3%
] CE OS Al CE M FH A2 7 SC R W - TI CE S48 A0 b A0 & B8 B sk & CE i 5 8%
FIT 75 B9 B A S50 30 ST ( an R R 32 7 T S A —AF) R IR AL T gy SOk TR
R E N CETFES.

BEEE R R CE T H A B WOR “Waiting...”, W HBOE R R THRER
G o QR AE SCAF AL it 12 v ATE SR 8 s SENL IR T 2B, T RE e kAR X
TGO o 0 R CLE S, 3 WOT B R CE ELRNE R BT 5 cE 8B
2 B SR W BT .

e L B AR S . 15 ) TEAT A SO i B R 2R . CE T
%Aflﬂé—lﬁﬂ{aﬂlfhﬂﬂf{f?ﬁ%%uzwﬁ?ﬁ}r‘ﬁﬂ CEl‘Fﬁ%ATﬁLﬁ*E’J%
/_\?glg—bﬁﬁﬁﬁ%@(E?‘EHFWW@) o AL, 2> 7E TI Connect CE & I I 5
NIHE .

Tg;ﬁ;’ﬁﬁh AR, CE AR A & MR AL B SCAF o 1 20 8 AR AR ST A% o A v 4R

RHESH -
R SO Rk B HE B T S8

EE

il H A 35


https://education.ti.com/84ceupdate
https://education.ti.com/84cetupdate

B $ T1-84 Plus CE THE 3%

Tl Connect™ CE X A1 T LU BITHE 28 T HIRIE R G-
#HE&TAE

o HARTHE UM (RAM. EREFNR FHFE SR ) -

o HPRTE B AR AT IT I A ] o B B T AL

o WIRAEH] USB MM SIS T 2 A THRE A, WA DU AR E T AR AT
HAE R Gt i

T DI i 75 “Send( %) 76 U HE fi i FR4F 7 T 5L B8 BUAT LR 1E

(2 455 < % 20 16 A By 1 A2 o W O e 0 0 ik

EFLETHBRIERS
1. il Actions( #:fE) > Send OS( R IZHIE R4) -
2. MBIV ENL AR X TR B AR AL S IR R R AR R G
3. .5 Open( 3T FF) »
“Send OS( RIXHRAE RG) "X HHE 2

2 send0S X

OS File:
TI84Plus_0S.8Xu

WARNING: Sending the OS will clear the memory on the destination calculators,
but archived items (apps. background images, etc.) will not be erased. Do you want
to send the OS now?

DESTINATION CALCULATORS:

_) All Connected Calculators ®) Select Calculators

) TI-84 Plus-D658

TI-84 Plus Silver Edition-CEBS

] Replace existing content with the same name on destination calculators

CANCEL SEND

4. M\ Destination Calculators( B A% i+ 2 8%) b 1E 47 1% £ -
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DESTINATION CALCULATORS:

0 All Connected Calculators (® Select Calculators
[¥] TI-84 Plus-D658

[¥] TI-84 Plus Silver Edition-CEBS

SEND

5. %“Send( Ki%)” .
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KR H R

i3 TI Connect™ CE B PF FT DAR HUA 56 1F S48 KM L 7 i 1D, #RAF R GE A
RAM. 714 . B S . ROM Ji 4 Fl B 25 fi 4 i 13 2. o

R HUAE AT SR 0 N A AR XSRS B

VER : TI-84 Plus CE £ 41K B 75 4 TI-84 Plus CE . 55 A XK T B E
FRHB 4> I BT 52 SR TI-84 Plus CE o

BEEIERER
» i view( &) > Calculator Information(i+ E 8= &) -

=2 Calculator Information >

Calculator: TI-34 Plus CE
Product ID:

_____ 05 Version:
RAM:

Archive:

Language:

ROM Version:

Hardware Version:

CLOSE

LB BB R
55 ) T - 84 Plus CE 15 J& 7 L3 (0 48 ML IO T 135
BRI BeAf R GEH — SO SR PRI B 2 3t

TI- BARE PR AR A B DUEH R ERGS 2 HE R R O R,

38 it H A



—&ER

LB

education.ti.com/eguide

TR B 2 M X DL UE 2 7 5 B .
BRI K 3 O

education.ti.com/ti-cares

1 165 BT A 1A I 5/ 481X AR BB AR AR G Al S 3 B U
JR %5 R R A5 B

education.ti.com/warranty

HEFE TR K /X, DORBCA R AR IR+ 46 37 dh A 55 145 2 .
A BRARAZ , TRAB T A A 2 5 i 465 1) 325 5 AR

B

education.ti.com/84ceupdate

education.ti.com/84cetupdate
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